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INTRODUCTION

The XBE Diversity Program with Sundt Construction Inc utilizes B2Gnow software to track and evaluate contract compliance
and participation on all construction contracts in accordance with Owners programs and requirements. The software is a
hosted service and can be located online at Sundt XBE Utilization Management System (diversitycompliance.com)

This manual is designed for subcontractors (referred to as Vendors in this manual) and outlines accessing the system,
responding to monthly compliance audits and training and support resources.

Finding and Managing Your Account

If you are uncertain if you have a current account/username, log on to the system at Sundt XBE Utilization Management

System (diversitycompliance.com). On the right-hand side of the screen, click on Account Lookup.
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System Training Account Access

Learn how to fully uilize our svstern with a live trainer Laookup Vendor accouss M 01l

About the System

On the Account Lookup screen, you can search by several factors including your business name or Tax |dentification number;
however, all usernames are tied to a specific email address, so it is the best criteria to use. In the Search by Contact
Information section, enter your email address, then click on Search at the bottom of the page.
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Search by Business Name or DBA Search by Tax Identification Number

Tip: Try a few letters of the firm's name. Tip: Must be 9 numbers; do not enter spaces or dashes.
Search by Contact Person

First Name Last Name

Tip: Use the first letter. Tip: Try the first few letters.
Search by Contact Information

Email Phone Number Fax Number

Tip: Try part of the email.

Search by Location
Address City State/Province

~

Based on user's location/address

‘ Search

If you are not able to locate your email address in the system, search your Business Name or Tax |dentification Number. Once
located you will want to select the option to “Request New User for This Entity” and fill out the required fields. The request
will be sent directly to Sundt to confirm and accept.

Request New User Close

Use this form to request a new user for your account.

Enter the user account information, your contact information, and any additional relevant details, Click the Submit button to send the message to
Customer Support. The security of the system is important, and all requests are verified prior to any action being taken. We may need to request
additional information to complete the process.

* required entry

Section 1: User Information

COMPANY/ ORGANIZATION NAME * Sundt Construction, Inc.

TAX ID NUMBER * Tax ID Number is used to verify the sccount.

USER'S NAME *

TITLE*

EMAIL *

PHOME NUMBER * Exn.
FAX NUMBER

NOTIFICATION Norify user of new account

Section 2: Your Message
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Once you have confirmed your email address is in the database, sign in using the Log In button.

If you were not given a password or do not remember your password, you can choose Forgot Password to have a one-time
password sent to your email.

Logging in for the First Time

The first time you log into the system, you will see a Welcome screen (Figure below). By default, a box is checked to prevent
this screen from appearing on future log-ins. The screen provides some basic information on security, navigating the system,
finding records and help and support. After reviewing the information, you can click Continue to proceed to your home page
(the entry screen for future logins).

@ M= System Dashboard
SUND Welcome to your new Dashboard!
- = = This teel can be personalized and configured te display exactly the information you want to see, in a simpler & cleaner
format.
Home
i Take advantage of many powerful features:
View »
* Control exactly what, where, and how to display data
Search » » Add multiple blocks of information
- * Place a block on the left or right of the Dashboard
Reporting » ) . s
* Setdata based on your ewn assigned records or the entire crganization
Create » = Mowve blocks up or down on the Dashboard
= (Change the color of a block to highlight impertant information
Tools » » New data options are added monthly
Settings » Click Personalize to get started.
Help & Support »
Logoff
Shiow All Hide All

The home page is the default entry screen for all subsequent logins. It incluces six distinct areas: the Dashhoard, Certification
Genter, Key Actions, Alert, System News and Configure.

The dashboard is the most important section of the home page, as it gives a quick view of your current contracts and any
actions needed. This section also lists Contract Audits. Contract Audits are the most essential function of this system for
reporting purposes and are discussed in more detail below. NOTE: Once you click Personalize you can customize to display
only records assigned to “only you”.
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Tre System Dashboard

SUN DT Contracts

| Total active 1
& D =] Audited L
Soon to end (3 mo) 1
| Home
Dizplaying User Data - Config
| View »
| Search » Payments % Goal
| Solthacts = Value For Credit % Cradic
| Reporting » All {open & closed) 1 $37MM %0 30%
$0 0.0%
| Create » All Opan i £370MM %0 3.0%
$0 0.0%
| Tools » All Audited 1 £370MM 0 0%
$0 0.0%
| Settings »
| = Dizplaying Uszer Data - Config
| Help & Support »
| Logoff Contract Audits Total <80 days >50dzys
show All Hide All Dizplaying User Data - Config

Favorite Reports

Mo favorite reports designated. Select your favorite reports.
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SETTING UP TIERED 5UBS + VENDORS

After logging in to the system, navigate to the toolbar and select View and then My Contracts. Select the
applicable contract in which you have been awarded.

Next, click on the Subcontractors tab on the top of the screen.

Contract Management: Subcontractor List

Contract Main  View Contract Subcontractors Compliance Audit List Compliance Audit Summary Messages Comments Reports

Sundt Construction Inc
132107: SDCRAA-Administration Building
Prime: Sundt Construction, Inc.

Your company name should populate on the subcontractor list. To assign a tier to your contract, click
the hyperlink to Add Tier 2 Sub

Subcontractor List

. Current
Sube N Certifed *
ortsitor Nare et Tyee

[1] sundt Construction. Inc. (-] /096 Sub

Find your applicable trade partner using the Get Vendor hyperlink and searching by the company name
or other relevant data points. If your search does not identify your trade partner, you will choose the
option to Add New Vendor
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* required entry

‘ Vendor Information

VENDOR * (Get Vendoaw vendor database

Once you have selected the correct trade partner, you will enter the Vendor Compliance Contact and
Vendor Address information. Note that the vendor compliance contact chosen will be the individual at
the company who will be required to confirm payments made to them in the system. You can select
more than one contact to get notifications. Further, the address chosen should be the local address who

is performing work or supplying materials.

* required entry

Vendor Information
VENDOR * AMERICAN VETERAN SUPPLY COMPANY (Change Yendor)
VENDOR COMPLIANCE CONTACT = Primary compliance contact (required):
Beni Monaco ~
Secondary compliance contact (optional):
None selected ~
This contact wifl receive copies of all compliance notices.
VENDOR ADBRESS = 5881 OBISPO AVENUE SUITE 106, LONG BEACH, CA 90805 ~

Note any applicable XBE certifications for your trade partner. If you notice that the company has
certifications that are missing from the platform, please reach out to your primary contact at Sundt with

the missing information.

Applicable Vendor Certifications

Type Organization

SBE California Department of General Services

Next, fill out all required (*) information under the Subcontract Information header. Ensure responses
align with the below instructions.

e Mark YES to include in compliance audits for any companies whose work is not fully complete
and paid as of the date you are adding them to the system.

INCLUDE IN COMPLIANCE AUDITS? * @ Yes - subcontractor is active and should be included in the periodic compliance audits of the contract.

O No - subcontractor is inactive.

e For any company who holds a certification applicable to the contract, mark YES to include in
goal and select the appropriate goal from the drop-down list.

OUNTTOWARDS CERTIFIED GOAL * © Yes - Payments to this subcontractor count towards the Goal

O No
e Click NO subcontractors first audit will be the next one and enter payments made to date to the
company.
ADD VENDOR TO BXISTING AUDITS FOR THIS CONTRACT? = O Yes - add this subcontractor to all audits going back to the period of| February | 2023

@ No. Subcontractor's first audit will be the next one.

Payments Already Made: 5| 5,000

e Inthe required comments section please enter “Adding tiered subcontractor/vendor”

Finally, review and submit your information. Once approved, you will be able to add third tier subs, or
instruct your second-tier subs to add their third tier subs in compliance with this document.
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Compliance Audits

Compliance audits are the key function of the B2Gnow system for compliance monitoring. On the first of each month, a new
“audit” is created for the previous month. An audit is simply the form used by you, the vendor, to report payments received
from a “specific project” and payments made to your subcontractors.

Upon creation of a new audit, you will receive an email notifying you that the audit has been opened and the due date for
reporting the required information. Key information is included at the top of the email including the Contract Name, Prime
Gontractor, Contract Number and reporting period. There is also a link provided. Clicking on the link will take you to the login
screen. Once you have logged into the system, you will be taken directly to the audit in question.

You may also open any contract audits from your system dashboard (as shown ahove).

The audit screen contains a variety of key information. This includes the contract number and name, the reporting time
period, the actions that you need to take, and key dates (the date the information is due and the date the audit will be
locked). NOTE: if an audit locks prior to your entering the required data, you will need to contact the assigned Compliance
Officer to have it re-opened. If you know in advance that you will not have the information available, you may request an
extension from the Compliance Officer.

There are two required actions: confirm payment(s) received from Sundt, and report payments made to your vendors.
A complete training on responding to compliance audits can be found by clicking Help & Support from the system home page

https://sundt.diversitycompliance.com and then selecting Video Library. In the Video Library, locate the Contract Compliance
Reporting training.

@ Video Library

Document Library Video Library Training Classes  Wish List
SUNDT

@« = @B S

Home

Select a categery: | All Categories v ‘ Search ‘ [ newonly

View » Core Training - Vendor

Search »
Contract Compliance Reporting Complete step-by-step instructions for responding to Contract Audits and Discrepancy notices
Message »
Hire Module Overview of the Hire module for vendors

Settings » .
Introduction to the System Systemn Navigation and Vendor Profile.

Help & Su rt »
P & Suppo Online Certification Application How to use the system to submit a paperless anline certification application

Contact Support

Quick Guide Complete siep-by-siep i

Complete step-by-step i

Learn how to access and complete Vendor Registration fory

If you prefer to attend a live training session, choose Training Classes under Help and Support, and register for one of the
weekly Contract Compliance Reporting - Vendor Trainings.
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Transactions: Events & Training Classes

Events may be available to attend. Click the links in the Action column to view information and details of a particular event. You can adjust the filters and date range to

SUNDT

Search
& = &
To resort click column title. To filter click drop down menu.
Home Actio Stat RSVP Event
View »
All N Al ~ Al v

Search »

RSVP Closed Contract Compliance Reporting - Vendor Training
Message »

RSVP Open, 42 space(s) left Online Certification Application - Vendor Training
Settings »

RSVP Open, 96 space(s) left Introduction to the System - Vender training
Help & Support »

RSVP Open, 145 space(s) left Contract Compliance Reporting - Vendor Training

Cantart Sannart

Training & Support

This manual covers the primary areas needed for reporting as required by Sundt. The system does have many other features
and we encourage you to explore them. You can receive additional training guides and videos from B2Gnow under Help &
Support on our system home page https://sundt.diversitycompliance.com. In addition, you can send questions directly to
Sundt within the system by navigating to Message and choosing the option to Send a Message or Contact Support.

Please e advised that reporting payments in the system is not a guaranteed condition to obtain progress payments. Make
sure any additional contractual obligations are fulfilled.
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